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Chapter 13 

Cable Management 

 
e-DPP is provided with functions to determine sizes of power cables and associate conduits/glands. 
 
The power cable sizing is performed for electrical loads, e.g. electrical motors static loads, distribution 
panels and lighting panels stored in the electrical load schedule. 
In order to perform the sizing, you need to input all the required data in the edit form dedicated to this 
purpose. The details are described in the Section 13.1. 
Also, the library data of motors and cables are referred by the sizing program. 
 
The conduit and cable gland sizing is performed for all or part of cables (power, control, etc.) stored in 
the cable schedule. 
In order to perform the sizing, "Conduit and Cable Gland Selection Table" needs to be created 
beforehand with the menu "Cable Management - Conduit and Gland Size". 
 
e-DPP Cable Management menu covers the following features: 
 

 Power Cable Sizing 
 Cable Sizing Chart 
 Drum Scheduling 
 Conduit & Gland Sizing 
 Cable Summary 
 Gland Summary 
 Minimum Cable Size 
 Conduit & Gland Size Table 
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13.1 Power Cable Sizing 
Prior to the execution of power cable sizing, the data described below are to be inputted for electrical 
loads. Select "All Electrical Loads" from "Edit" menu in the menu bar and then select "Input Data 
for Cable Sizing" from the template list when using the e-DPP standard form. 

Motors (Induction, Synchronous and MOV) 
• Equip. Code (0, 1, and 2) 
• Motor Output 
• Unit of Motor Output (HP, kW or KVA) (*1) 
• Motor Rated Voltage (kV) (*1) 
• No. of Phase (*1) 
• Full Load Current (A) (*1) 
• PF at 100% Load (%) (*1) 
• Locked Rotor Current (%) (*1) 
• Locked Rotor PF (%) (*1) 
• Raceway type 
• Conductor type (Cu or Al) (*2) 
• Cable Voltage (*2) 
• Cable Type (XLPE/SWA, etc) (*2) 
• No. of Cable Conductors (*2) 
• Unit for No. of Cable Conductors (Usually "Core" for power cables) (*2) 
• Cable Length (m) 
 
DC Motors 
Static Loads 
Capacitors 
Lumped Loads 
UPS's 
VFD's 
Battery Chargers 
Heaters 
Space Heaters 
Feeder Circuits 
Lighting Circuits 
 
• Equip. Code (3 to 15) 
• Rated Capacity 
• Unit of Rated Capacity (HP, kW, KVA or kvar) (*1) 
• Load Rated Voltage (kV) 
• Full Load Current (A) (*1) 
• PF at 100% Load (%) (*1) 
• Raceway type 
• Conductor type (Cu or Al) (*2) 
• Cable Voltage (*2) 
• Cable Type (XLPE/SWA, etc) (*2) 
• No. of Cable Conductors (*2) 
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• Unit for No. of Cable Conductors (Usually "Core" for power cables) (*2) 
• Cable Length (m) 
 
(*1) The characteristic data for motors and static loads can be filled out with the Data Filling program, 
as required. 
 
(*2) The data for cable specification may be omitted since the sizing program has the option to fill out 
user specified defaults. See the section 13.1.1 for further details. 
 
(*3) Power cable ID is not necessarily required for the power cable sizing. However, cables with no 
ID's will not be transferred to a cable schedule since cable ID is essential. 
 
 
13.1.1 Cable Sizing Criteria 

 
<Dialog of Cable Sizing Criteria> 

 
When you select the menu "Cable Management" → "Power Cable Sizing", the dialog as shown 
above will appear. Here, you can specify the various parameters required for the sizing. 

Criteria of Cable Sizing 

Allowable Voltage Drop (%) 

Motor - Running - LV 
Allowable voltage drop in % against a system voltage for low voltage motors (kV <= 1.0) at normal 
running. Typical value is 3-5%. 
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Motor - Starting - LV 
Allowable voltage drop in % against a system voltage for low voltage motors (kV <= 1.0) at starting. 
Typical value is 15-20%. 

Motor - Running - HV 
Allowable voltage drop in % against a system voltage for high voltage motors (kV > 1.0) at normal 
running. Typical value is 3-5%. 

Motor - Starting - HV 
Allowable voltage drop in % against a system voltage for high voltage motors (kV > 1.0) at starting. 
Typical value is 15-20%. 

Motor - Running - DC 
Allowable voltage drop in % against a system voltage for DC voltage motors at normal running. 
Typical value is 3-10%. 
 
(Note: Starting current of DC motor is not considered.) 

Static Load - Operating - LV 
Allowable voltage drop in % against a system voltage for low voltage static loads (kV <= 1.0) at 
normal operation. Typical value is 1-5%. 

Static Load - Operating - HV 
Allowable voltage drop in % against a system voltage for high voltage static loads (kV > 1.0) at 
normal operation. Typical value is 1-5%. 

Feeder - Main - LV 
Allowable voltage drop in % against a system voltage for low voltage main feeder circuits going to 
medium or large distribution panels (kV <= 1.0) at normal operation. Typical value is 1-3%. 

Feeder - Branch - LV 
Allowable voltage drop in % against a system voltage for low voltage branch feeder circuits going to 
small distribution panels (kV <= 1.0) at normal operation. Typical value is 2-5%. 

Feeder - Main - HV 
Allowable voltage drop in % against a system voltage for high voltage main feeder circuits going to 
medium or large distribution panels (kV > 1.0) at normal operation. Typical value is 1-3%. 

Feeder - Branch - HV 
Allowable voltage drop in % against a system voltage for high voltage branch feeder circuits going to 
small distribution panels (kV > 1.0) at normal operation. Typical value is 2-5%. 

Lighting - Main - LV 
Allowable voltage drop in % against a system voltage for low voltage main lighting circuits going to 
medium or large lighting panels (kV <= 1.0) at normal operation. Typical value is 1-5%. 

Lighting - Branch - LV 
Allowable voltage drop in % against a system voltage for low voltage branch lighting circuits going to 
small lighting panels (kV <= 1.0) at normal operation. Typical value is 1-5%. 
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(Note: System voltages are specified in the menu "Project" → "Electrical".) 

Apply Default Minimum Cable Sizes 
Check this box to apply predetermined minimum cable sizes for individual motor loads. When this 
option is applied and then calculated cable sizes are less than the corresponding minimum cable sizes, 
the latter is taken as calculation results. 

"Show Min. Cable Size" Button 
To define or edit the minimum cable sizes for motor loads, click "Show Min. Cable Size" button. 
"Minimum Cable Sizes" dialog box appears.  
 
(Note: The minimum cable sizes can be also accessed from the menu "Cable Management" → 
"Minimum Cable Size".) 
 

 
<Dialog of Minimum Cable Sizes> 

 
When cable sizing is run, the saved values from this dialog box will be reflected on the power cable 
sizing results. 
 
(Note: For DC motor cables, option for "Minimum Cable Sizes" is ignored.) 

Adjust by Ambient Temp. (deg.C) (Ta) 
When this option is selected, the temperature adjustment factors Fta is calculated (approximately) for 
each installation method ("U/G" or "A/G") by the difference between the base and actual ambient 
temperatures of cable installation with the following formula; 
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TaTc
TTcFta

−
−

=  

 
Where 

Tc: Maximum conductor temperature 
Ta: Base ambient temperature 
T : Actual ambient temperature 

 
Tc and Ta are stored in the cable library. T is selected from the pull down list "U/G" or "A/G" by user. 
Calculation results are shown in the column "Temp Factor" in "Cable Application" section below. 

Target Data for Cable Sizing 

Sized or Unsized 

Unsized Power Cables Only 
When this option is selected, power cables in the electrical load schedule where cable sizes are blank 
(including Error code) or #Wire/Phase is zero (0) become the targets for the sizing. 

All Power Cables 
When this option is selected, all power cables in the electrical load schedule become targets for the 
sizing. These will overwrite the existing sizes unless "Lock" option is specified on the electrical load 
schedule. 

Cable Library 

Use Available Cable Sizes Only 
When this option is selected, only the cable sizes in the cable library where the field [Available] = Yes 
become available for the sizing. 

Use All Cable Sizes 
When this option is selected, all the cable sizes in the cable library become available for the sizing. 

Type of Electrical Equipment 
Clicking "Details" button brings up "User Options" - "Cable Sizing" tab. Users could select equipment 
types to include in the cable sizing calculation.  
The equipment types are specified in the menu "Edit" → category "All Elec. Loads" → some editor 
screens. 
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Type of Driven Loads 
The target motors for cable sizing can be filtered by the type of their driven load.  This option allows 
user to specify different sizing criteria such as the derating factors for different types of motors 
(according to driven load).  For example, in the case of air fin coolers where normally no spare 
machines are provided in the air fin bays, their power cables carry current nearly to their designed 
ampacity limit. 

Exclude Locked Items 
Overwriting data for locked items is impossible on eDPP. However, this option is an exception. Cable 
sizing can be performed irrespective of the value of individual "Locked" flag. 
When this check box remains checked, "Locked" records are excluded from the scope of cable sizing 
algorithm. 

Cable Application 

Overwrite Cable Voltage & Type 
When this option is selected, cable voltages, cable types and no. of cores specified here will have 
priorities for the sizing. Existing cable sizes will be overwritten on the electrical load schedule. 

Manufacturer 
Select a manufacturer for the cable sizing data reference. The default value initially set is "DPP". 

Frequency (Hz) 
The power frequency from the menu "Project" → "Standard" is shown here. 
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Units 
The units of cable dimensions selected in the menu "Project" → "Standard" is shown here. 

Standard 
The applied standard of cable selected in the menu "Project" → "Standard" is shown here. 

Voltage Class 

Run Sizing 
Select the desired voltage classes on which to perform the sizing. 

Load kV 
The motor rated voltages selected in the menu "Project" → "Electrical" are shown here. 

Cable Voltage 
The rated cable voltages defined in the menu "Project" → "Electrical" are shown. It is necessary to 
define the cable rated voltage prior to the sizing calculation if cable types on this GUI is to be selected. 

U/G and A/G 
Indicate the appropriate cable type and grouping factor to be used in the cable sizing for each voltage 
class and type of installation i.e. U/G and A/G 

Cable Type 
You can select cable type from the list box for each voltage class and each type of cable installation, 
A/G (Above ground) or U/G (Underground). 
 
The correspondence with the raceway type is as follows; 
 

U/G Duct U/G (Raceway Type = 0) 
U/G Buried U/G (Raceway Type = 1) 
A/G Trays A/G (Raceway Type = 2) 
A/G Conduit A/G (Raceway Type = 3) 
Air Drop A/G (Raceway Type = 4) 

Temp Factor 
The temperature derating factor is automatically displayed here.  The calculation of this factor is 
described in "Adjust by Ambient Temp. (deg.C) (Ta)" above. 

Group Factor 
You can specify grouping factors in the range of 0.01 to 1.00 for each voltage class and each type of 
cable installation. The grouping factors reflect installation method of cable conductors, e.g. spacing, 
trefoil, parallel, trays, etc. e-DPP does not consider adjustment factors for differences in soil thermal 
resistivity or depth of buried cables, these factors may be included into the grouping factors for a 
practical solution. 

Application MF 
Specify the desired Application MF (Multiplying Factor) for motor and static load independently. The 
Application MF is used to derate the cable ampacity (MF times full load current). 
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13.1.2 Command Buttons 

Run 
After all the parameters are set above, click "Run" button to execute power cable sizing. If one or 
more cables were tagged for sizing, "Results" window appears as shown in the next page, Section 
13.1.3. 

Save 
To save the parameters set above, click "Save" button. 

Print 
An image of this active window is pasted to Word Pad file. You can print the image showing all the 
parameters. 

Help 
Click on "Help" button to open On-Line help file. 

Close 
Click on "Close" button to close this dialog window of Cable Sizing Criteria. 
 
 
13.1.3 Results 

 
<Dialog of Cable Sizing Results> 

 
When "Run" button is clicked, the calculation of power cable sizing starts and the above window will 
be shown. 
The cells filled with yellow color mean newly substituted values by the program. 
The cells filled with blue color mean erroneous values (usually 0) that cause failure of the sizing. You 
need to correct those values in the editor and run the sizing program again. 
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Table of Sizing Results 
This window indicates the results of cable sizing including; 

Size 
This column indicates calculated cable sizes. If the sizing fails and no cable size have been determined, 
error codes are filled in these cells instead of normal cable sizes. 
 

Error Code Reason of Sizing Failure 
Err_1 Cable length is zero. 
Err_2_1 System voltage is zero. 
Err_2_2 Load voltage is zero. 
Err_3_1 Motor locked rotor current is zero. 
Err_3_2 Full load current is zero or negative. 
Err_3_3 Power factor is zero. 
Err_4_1 Cable resistance is zero. 
Err_4_2 Cable reactance is zero. 
Err_5 Cable ampacity data in the library are empty. 
Err_6 Number of wires per phase exceeded 9 

#/Ph 
This column indicates the number of parallel conductors per phase (Max. 9). If this figure exceeds 9, 
the program terminates the sizing calculation and goes to the next electrical load. (Error code: "Err_6") 

Length (m) 
Length of cable in meter entered in the electrical load schedule. 

Resistance (Ohm/km) 
Resistance value of cable in ohms per one kilometer retrieved from the cable library. If #/Ph is more 
than 1, the value is divided by #/Ph value. 

Reactance (Ohm/km) 
Reactance value of cable in ohms per one kilometer retrieved from the cable library. If #/Ph is more 
than 1, the value is divided by #/Ph value. 

Nominal Ampacity 
Ampacity of the cable in ampere (base ampacity) before any adjustment (no de-rating factors is 
applied) retrieved from the cable library. 

Temp Adj Factor 
Derating factors for cable ampacity due to difference between base temperature on which cable is 
rated and the ambient temperature where the cable will be laid. 

Group Factor 
Derating factor for cable ampacity due to the grouping effect of cable installation in raceway. This 
factor is manually determined outside of e-DPP. 

Derating Factor 
Overall derating factor (Grouping factor * Temperature factor) 
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Derated Ampacity 
Calculated cable ampacity multiplied by the overall derating factors. 

%VD at Running 
Calculated voltage drop (%) for the selected cable size at normal running condition. 

Max. Length Run (m) 
Maximum allowable length (m) of the selected cable size at normal operation 

%VD at Starting 
Calculated voltage drop (%) for the selected cable size at motor starting. 

Max. Length Start (m) 
Maximum allowable length (m) of the selected cable size at motor starting 

FLA/Temp Amp 
Ratio of the full load current of the connected load and the de-rated cable ampacity due to the "Temp 
Adj Factor" only ("Group Factor" not included). 

Min. Size 
If "Apply Default Minimum Cable Sizes" is selected, the minimum cable sizes for individual rated 
motors are retrieved from the minimum cable size table. This option is applicable for motors only (not 
for static loads). 

Final Select Size 
Select any cable size from the drop down list to alter the calculated size. This size will serve as the 
final size of the cable under consideration.  If "Final Select Size" is not explicitly specified, the 
calculated size will take the precedence. 
When selecting a new size different from the calculated one, a "Go" button will be shown in the 
adjacent column "Re-Calc". Clicking this button will result to a new set of calculated values based on 
the specified size. Parameters modified due to these results will be indicated in pink color. 
 
(Note: An alert message will appear when the selected cable size from the drop down list is less than 
the calculated value, "Selected size is smaller than the calculated one! Changing the size will result in 
non-conformance with the sizing criteria".)  

Key Factor 
The number indicating key factors by which criteria the cable sizes have been determined are shown in 
this column. 
 

Key Factor = 1: By Ampacity 
Key Factor = 2: By Voltage drop at normal running 
Key Factor = 3: By Voltage drop at motor start 
Key Factor = 4: By Minimum Cable Size 
Key Factor = 5: By User Selection 

Re-Calc 
A "Go" button will be displayed to indicate that a new size (different from the calculated value) was 
selected from the "Final Selected Size" column.  Refer to "Final Selected Size" above. 
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Note 1: It is not allowed to alter the calculated value of #/Ph. Even when you change the size, the recalculation 
will be carried out based on the indicated #/Ph value. 
 
Note 2: Even if you don't carry out the recalculation, the selected size in the column "Final Selected Size", if any, 
will designate the final size of the cable. 

Lock All/Unlock All 
Locking or unlocking of all the records in a single click is possible with this option. In this way, 
records will be secured from overwriting. 

Sizing Filter 
In this option, calculated cable results will be filtered to show "all", "sized", or "unsized" items. 

All 
All the cables are shown regardless of sizing results. 

Sized 
Only cables with succeeded sizing results will be shown. 

Unsized 
Only cables for which the sizing failed and have the error codes (Err_***) will be shown. 

Select Filter 
You can filter the spread window with a field value of column where the cursor is currently located. 

Filter 
Only records that have the same cell value in a column where the cursor is located will be shown. 

Remove 
Reset the selected filter to show all the records. 

Multi-Sort (+ Load ID) 
You can sort the spread data with the following 6 option buttons; 
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None 
Sorted by Load ID in an ascending order. 

kV 
Sorted by Load rated voltage in a descending order and Load ID in an ascending order. 

Eq Type 
Sorted by Equipment code and Load ID both in an ascending order. 

Type/kV 
Sorted by Equipment code (ascending), Load rated voltage (descending) and Load ID in an ascending 
order. 

Cab Spec 
Sorted by Cable voltage, Cable type, No. of cores and Load ID all in an ascending order. 

Inst. 
Sorted by raceway type and Load ID both in an ascending order. 
 
(Note: Clicking the column headers can also sort the spread window. Subsequent clicks toggle 
ascending and descending orders.) 

Command 

Save 
Click this button to save the sizing results shown in this window. However, if "Lock" protection is set 
"ON" in the electrical load schedule, new calculated cable sizes will not be overwritten. 

To Excel 
The sizing results can be exported to e-DPP predefined or user-defined Excel form. After clicking this 
button, another dialog box will be shown where in the user can specify items (form to be used, page 
feed condition, etc.) as desired. 
 

 

"Template Name" 
Select any form from the pull down list to which the cable sizing results will be exported. 
A predefined user form can be defined in the menu "Template" → "Cable Sizing Result". 
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"Excel File Name" 
A different Excel template can be defined. However, changing it might cause mismatches in cell 
addresses against the selected template. 

"Sheet Feed by" 
This option allows user to define a base field (kV, System kV, MotVoltageClass, etc.) where the output 
should be categorized as sheets in excel. 

Preview 
Click on "Preview" button to show printable layout of the generated cable sizing result. 

Preview Toolbar 
 

 

"Next" 
Click on "Next" button to navigate the next page (grayed-out if the preview contains only one page or 
if the preview is on the last page). 

"Previous" 
Click on "Previous" button the navigate to previous page (grayed-out if the preview contains only one 
page or if the preview is on the first page). 

"Zoom" 
Click on "Zoom" button to zoom-in or out the preview layout. 

"Print" 
Click on "Print" button to bring up the Print dialog box to start and print job. 
 
(Note: Print setup is also accessible in this menu.) 
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"Setup" 
Click on "Setup" button to display the Setup dialog box, which contains options that allows user to 
define printing preferences. 

"Close" 
Click on "Close" button to close and return to Cable Sizing result Dialog. 

Help 
Click on "Help" button to open On-Line help file. 

Close 
Click on "Close" button to save (apply the result of the cable sizing) and return to the dialog of Cable 
Sizing Criteria. 
 
 
13.1.4 Calculation Formulas 
The criteria of power cable sizing implemented in e-DPP are expressed by the following three 
categories; 
 

(1) Derated cable ampacity vs. load current 
(2) Voltage drop (%) at normal load operation 
(3) Voltage drop (%) at motor start (For motor loads only) 

 
The detailed procedures and formulas for power cable sizing are described below. 
 
 
13.1.4.1 Cable Ampacities 
"Temperature Factor" 
When "Adjust by Ambient Temp. (Ta)" is selected on the entrance menu, the temperature factor Fta is 
calculated with the approximation formula for each installation method ("U/G" or "A/G") by the 
difference between the base and actual ambient temperatures of cable installation; 
 

TaTc
TTcFta

−
−

=  

 
Where 

Tc: Maximum conductor temperature  
Ta: Base ambient temperature  
T : Actual ambient temperature 

 
The result of calculated Fta is referred by the cable sizing calculation and reflected to the overall 
"Derating Factor". 
If this option is not selected, the default value 1.00 is substituted in Fta. 
 
"Grouping Factor" 
You can input grouping factor Fg for each cable installation type on the entrance menu. The product of 
Fg and Fta becomes an overall derating factor. 
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"Comparison with Load Current" 
The derated cable ampacity is compared with a load current multiplied by "Application MF" that can 
be inputted on the entrance menu. 
 

[Cable Ampacity] * Fta * Fg > [Application MF] * [Load Current] 
 
If the above condition becomes true, then the program goes to the next step to calculate a voltage drop. 
If false, the next larger size of cable in the cable library will be examined. 
 
 
13.1.4.2 Unit Adjustment for R & X 
Prior to the voltage drop calculations, the program converts cable resistances and reactances into the 
unit of "ohm per 1 km" since the cable library may include several units for cable length. 
 
 
13.1.4.3 Voltage Drop at Normal Operation 

Maximum Cable Length at a Given Voltage Drop at Normal Operation 
The calculation formula for the maximum length of cable against the specified voltage drop at normal 
running varies depending on the types of loads as follows. 
 
(1) 3-phase Motor 
 

( )θθ
ε

sincos3
10000

)(
xrI

V
ml s

+××

××
=  

 
Where 
l (m):  Maximum cable length (m) 
ε(%): Specified voltage drop (%) 
Vs (kV): System (bus) voltage (kV) 
I (A)  Motor full load current (A) 
r (ohm/km): Resistance of cable (ohm/km)  
x (ohm/km): Reactance of cable (ohm/km) 
cosθ:  Motor power factor at full load 
sinθ:  Motor reactance factor at full load 

 
(2) 1-phase Motor 
 

( )θθ
ε

sincos2
10000

)(
xrI
V

ml s

+××
××

=  

 
(3) 3-phase Static Load (incl. Capacitor, UPS, Feeder, Lighting Circuit, VFD, Battery 

Charger, Heater, Space Heater and Lumped Load) 
 

The calculation formula for the maximum cable length is given below by using KVA of a 
static load. 
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( )θθ
ε

sincos
10000
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2
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V

ml s
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××

=  

 
Where 
l (m):  Maximum cable length (m) 
ε(%): Specified voltage drop (%) 
Vs (kV): System (bus) voltage (kV) 
r (ohm/km): Resistance of cable (ohm/km)  
x (ohm/km): Reactance of cable (ohm/km) 
cosθ:  Power factor of static load at full load 
sinθ:  Reactance factor of static load at full load 

 
(4) 1-phase Static Load 
 

( )θθ
ε

sincos
5000

)(
2

xrKVA
V

ml s

+×
××

=  

 
(5) DC Motor 
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V

ml s

××
××

=
2

10000
)(

ε
 

 
If the calculated l(m) is greater than or equal to the length of load cable, the program goes to the next 
step to calculate a voltage drop at motor start. 
If not, the next larger size of cable in the cable library will be examined. 

Voltage Drop at a Given Cable Length at Normal Operation 
 
The formulas for voltage drop (%) at normal operation are as follows; 
 
(1) 3-phase Motor 
 

( )
sV

xlrlI
×
+××

=
10000

sincos3(%) θθε  

 
where 
ε(%): Calculated voltage drop (%) by the selected cable size 
l (m): Actual cable length (m) of load 
Vs (kV): System (bus) voltage (kV) 
I (A): Motor full load current (A) 
r (ohm/km): Resistance (ohm/km) of the selected cable size 
x (ohm/km): Reactance (ohm/km) of the selected cable size 
cosθ: Motor power factor at full load 
sinθ: Motor reactance factor at full load  

 
(2) 1-phase Motor 
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( )
sV
xlrlI

×
+××

=
10000

sincos2(%) θθε  

 
(3) 3-phase Static Load 
 

( )
210000

sincos(%)
sV
xlrlKVA

×
+×

=
θθε  

 
Where 
ε(%): Calculated voltage drop (%) by the selected cable size 
KVA: Capacity of static load (kVA) 
l (m): Actual cable length (m) of load 
Vs (kV): System (bus) voltage (kV) 
r (ohm/km): Resistance (ohm/km) of the selected cable size 
x (ohm/km): Reactance (ohm/km) of the selected cable size 
cosθ: Power factor of static load at full load 
sinθ: Reactance factor of static load at full load 

 
(4) 1-phase Static Load 
 

( )
25000

sincos(%)
sV

xlrlKVA
×
+×

=
θθε  

 
(5) DC Motor 
 

sV
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×
××

=
5000

(%)ε  

 
 
13.1.4.4 Voltage Drop at Motor Start 

Maximum Cable Length at a Given Voltage Drop at Motor Start 
The maximum cable length against the specified voltage drop (%) is calculated with the formula; 
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Where 

lS (m):  Maximum cable length (m) 
εS (%): Specified voltage drop (%) 
r (ohm/km): Resistance of cable (ohm/km)  
x (ohm/km): Reactance of cable (ohm/km) 
Z (ohm): Motor impedance at starting 
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  <[PhaseNo]="3"> 

 
II

V
Z

s

m

××

×
=

3
100000

 

 
  <[PhaseNo]="1" or "DC"> 
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Vm (kV): Motor rated voltage (kV) 
I (A)  Motor full load current (A) 
Is (%)  Motor locked rotor current (%) of I 
R (ohm): Motor resistance at starting 

SZR θcos×=  
X (ohm): Motor reactance at starting 

SZX θsin×=  
cosθS: Motor power factor at starting 
sinθS: Motor reactance factor at starting 

 
If the calculated l(m) is greater than or equal to the length of load cable, this cable size will be taken as 
a calculation result. 
If not, the next larger size of cable in the cable library will be examined. 

Voltage Drop at a Given Cable Length at Motor Start 
 
The formula for voltage drop (%) at motor start is; 
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Where 

εS (%): Calculated voltage drop (%) by the selected cable size 
l (m): Actual cable length (m) of load 
r (ohm/km): Resistance (ohm/km) of the selected cable size 
x (ohm/km): Reactance (ohm/km) of the selected cable size 
Z (ohm): Motor impedance at starting 
R (ohm): Motor resistance at starting 
X (ohm): Motor reactance at starting 
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13.2 Cable Sizing Chart 
The program of "Cable Sizing Chart" generates a selection table for power cable sizes. The calculation 
formulas used in the program are the same as those for Power Cable Sizing descried in Chapter 13.1 
and based on allowable cable ampacity, voltage drop ratios at normal operation of load and motor 
starting. 
The databases referred to by the program, i.e. motor, cable and static load, have the same structures as 
those of e-DPP and hence, editable with e-DPP library menu. 
 
 
13.2.1 Command Buttons 
 

 

Open 
All the parameters set in 5 pages (see 16.1.2 to 16.1.6) are stored in Parameter file with the file 
extension .prm. Click on "Open" button to select an exiting parameter file. The program loads the 
stored parameters into 5 pages. 

Save 
Click on "Save" button to save modified or newly defined parameters in the same file name. 

Save As 
Click on "Save As" button to save modified or newly defined parameters in a different name of file. 

To Excel 
Click on "To Excel" button to generate a cable sizing chart with the parameters defined in 5 pages. 
MS-Excel automatically launches and indicates a chart sheet. Use the Save As menu command of MS 
Excel when saving the Excel sheet with a different file name. The default name of generated Excel 
sheet is "DPPCabChart.xls". 

Help 
Click on "Help" button to open On-Line help file. 

Exit 
Click on "Exit" button to terminate the cable sizing chart program (not e-DPP program). 
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13.2.2 General Page 
Project information you entered in this page appears in the header and/or footer parts of Cable Sizing 
Chart (MS Excel sheet). 
 

 

Project Information 

Customer 
Name of customer is up to 50 alphanumeric characters. This data is retrieved from Project Information 
(See Chapter 8.1) and not editable by user. 

Project Title 
Project title is up to 30 alphanumeric characters. This data is retrieved from Project Information (See 
Chapter 8.1) and not editable by user. 

Job No. 
Job number is up to 20 alphanumeric characters. This data is retrieved from Project Information (See 
Chapter 8.1) and not editable by user. 

Document No. 
Enter any alphanumeric characters for user document no. 
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Date 
Enter any alphanumeric characters for execution, saving or print date. 

Rev. No. 
Enter any alphanumeric characters for revision no. of chart 
 
Note: When using 0 (zero) for the revision no. and the setting of "Zero values" is unchecked in 
MS-Excel Tools → Options → View, 0 (zero) will not be shown in MS-Excel sheet. In this case, 
please enter '0 (single quotation mark + zero) in this Rev. No. cell. 

MS Excel Form 
You can select the output form either "e-DPP Predefined Form" or "User Defined Form". If you click 
"User Defined Form" option, the pull down list becomes enabled and you can select any of user 
defined forms that you have customized in the menu "Template" → "Cable Sizing Chart…". 
 
 
13.2.3 Criteria Page 
Criteria you defined in this page is used by the calculation formulas of maximum cable length. 
 

 

System Data 
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System Nominal Voltage (kV) 
Select or enter nominal voltage of bus supplying motor/load in kilo-volt. Generally, this voltage is 
different from motor/load rated voltage. 

System Frequency 
Select either 50Hz or 60Hz. 

Max. Voltage Drop @ Normal Running (%) 
Select or enter allowable maximum voltage drop in % against a system voltage at normal running. 
Typical value is 3-5% for motors and 1-5% for static loads. 

Max. Voltage Drop @ Motor Starting (%) 
Select or enter allowable maximum voltage drop in % against a system voltage at motor starting. 
Typical value is 15-20%. This option is disabled when static load type is selected in "Load Type" of 
Load/Motor Page. 

Wiring System 
Select the numbers of phases and wires for applied circuit system. 

Cable Derating Data 

Installation 
Select raceway type of power cable from Duct Bank, Direct Buried, Free Air and Conduit Air. The 
program obtains ampacity data from the cable library according to this selection. 

Ambient Temperature (deg. C) 
Select or enter ambient temperature of cable. The program calculates a compensation factor Fta in 
comparison with the base ambient temperature stored in the reference database, and indicates in the 
"Derating Factor" cell. 
The calculation formula is given below. 
 

TaTc
TTcFta

−
−

=  

 
Where 

Tc: Maximum conductor temperature 
Ta: Base ambient temperature 
T : Actual ambient temperature 

 
Tc and Ta are stored in the cable library. T is entered by user. 

Grouping Factor 
You can specify grouping factors in the range of 0.01 to 1.00. The grouping factors reflect installation 
method of cable conductors, e.g. spacing, trefoil, parallel, trays, etc. e-DPP does not consider 
adjustment factors for differences in soil thermal resistivity or depth of buried cables, these factors 
may be included into the grouping factors for a practical solution. 

Total Derating Factor 
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e-DPP automatically calculates the total derating factor as a product of the compensation factor of 
ambient temperature and the grouping factor. 
 

Total Derating Factor = Fta * Grouping Factor 
 
 
13.2.4 Load/Motor Page 

 

"Select Library File" Button 
Click on this button and select a new file on the dialog to change the reference library. 

Load Type 
Select either Motor or Static Load. When Static Load is selected, the criterion of voltage drop % at 
motor starting is not applied. 

Load Specification 

Output Unit 
Select either KW or HP. The load output values are indicated in the selected unit on the chart. 
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Number of Phase 
Select either 3 or 1 (single). The calculation formulas of cable voltage drop vary on the selected 
number of phase. 

Manufacturer 
Select a name of manufacturer from the pull down list. The selected manufacturer is used as a key 
field to retrieve the data from static load or motor library. 

Rated Voltage 
Select a rated voltage of static load or motor from the pull down list. The selected rated voltage is used 
as a key field to retrieve the data from static load or motor library. 

Enclosure Type 
Select a type of enclosure for motors from the pull down list. The selected type is used as a key field to 
retrieve the data from motor library. When Static Load is selected, this selection list is disabled. 

Number of Poles 
Select the number of poles for motors from the pull down list. The selected figure is used as a key field 
to retrieve the data from motor library. When Static Load is selected, this selection list is disabled. 

"Edit Motor Library" Button 
To change the motor library data in the selected library file, click on this button and go to the motor 
library menu. Changes made though this button also permanently affect the library data. 

"Edit Static Load Library" Button 
To change the static load library data in the selected library file, click on this button and go to the static 
load library menu. Changes made though this button also permanently affect the library data. 
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13.2.5 Cable Page 

 

Cable Specification 

Standard 
Select an applicable standard of cable from the pull down list. The selected standard is used as a key 
field to retrieve the data from cable library. 

Unit System 
Select either Metric (mm2) or English (AWG, kcmil, MCM). The selected unit system is used as a key 
field to retrieve the data from cable library. 

Manufacturer 
Select a name of manufacturer from the pull down list. The selected manufacturer is used as a key 
field to retrieve the data from cable library. 

Conduit Installation 
Not selectable. Only Non-Mag option is available. 

Conductor Type 
Select either Co (Copper) or Al (Aluminum) for cable conductor type. 
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Rated Voltage 
Select a rated voltage of cable from the pull down list. The selected voltage is used as a key field to 
retrieve the data from cable library. 

Insulation Type 
Select an insulation type of cable from the pull down list. The selected type is used as a key field to 
retrieve the data from cable library. 

Number of Cores 
Select the number of cable cores from the pull down list. The selected number is used as a key field to 
retrieve the data from cable library. 

Type of Cores 
Select a type of cable cores from the pull down list. The selected type is used as a key field to retrieve 
the data from cable library. 
"C" stands for Core, "P" for Pair, "T" for Triplex or Triad, etc. 

Temperature Data 

Base Temperature (A/G) (deg. C) 
Retrieved data from the referenced library for base temperature (above ground) is indicated in this cell 
and not editable by user. 

Base Temperature (U/G) (deg. C) 
Retrieved data from the referenced library for base temperature (underground) is indicated in this cell 
and not editable by user. 

Max. Conductor Temp (deg. C) 
Retrieved data from the referenced library for maximum conductor temperature is indicated in this cell 
and not editable by user. 

"Edit Cable Library" Button 
When you like to change the cable library data in the selected library file, click on this button and go 
to the cable library menu. Changes made though this button also permanently affect the library data. 
 



Cable Management  Cable Sizing Chart 

ELTECHS Engineering & Consulting Co., Ltd. 13-28 e-DPP 3.0 
 

13.2.6 Others Page 

 

Other Settings 

Max. Cable Length to Show (m) 
Specifying the maximum length here, the calculation results of allowable cable length that exceed the 
specified figure are not shown in the cable sizing chart (MS-Excel sheet). 

Multiplying Factor (MF) 
To adopt multiplying factors to the full load currents of static loads or motors, you can specify 2 
figures with a boundary of current value. 
The factors affect only cable ampacity calculation but not voltage drops. See Chapter 13.2.7 
"Calculation Formulas" 

Number of Parallel Cables 
In addition to the chart for single run cable (default), other charts for parallel cables can be generated. 

"1", "2", "3", "4" & "5" Checkboxes 
Check any boxes of number "2" to "4" when you want to create additional cable sizing charts for 
parallel runs. The number "1", "2", "3", "4" & "5" mean the number of parallel cables. The checkbox 
"1" is always checked as default. 
Additional charts for parallel cables will be created in new sheets of the same MS Excel book with the 
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sheet name "Parallel 2", "Parallel 3" and so on. 

Minimum Cable Size of Parallel Runs 
Usually the minimum cable sizes for parallel runs are different from (larger than) the ones for single 
run cables. Select the minimum size from the pull down list for parallel runs. The columns of cable 
data of which the sizes are less than the selected minimum size are not shown in created charts. 

Minimum Cable Sizes 
Use this option to reflect the minimum cable sizes specified in the menu "Cable Management" → 
"Minimum Cable Size…". This option is applicable to motors only. 

Apply 
The minimum cable sizes are taken into account when creating the charts. 

Ignore 
The minimum cable sizes are not taken into account when creating the charts. 

"Show Min. Cable Size" Button 
To define or edit the minimum cable sizes for motor loads, click "Show Min. Cable Size" button. 
"Minimum Cable Sizes" dialog box appears.  
 

 
<Dialog of Minimum Cable Sizes> 

Length Cell of Min. Size 
This option determines the color of intersectional cell of the minimum size of cable data column and 
motor data row. 
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Default : Default background color does not change. 
Yellow Color : Background color changes to yellow. 

Length Cell under Min. Size 
This option determines the presentation of cell in which cable sizes are less than the minimum cable 
sizes. 
 

Blank : Calculated maximum cable lengths are not shown. 
Gray Color : Background color changes to gray. Calculated lengths remains in cells. 

 

 
<Coloring of Minimum Cable Size Options> 

 
 
13.2.7 Calculation Formulas 
The criteria of power cable sizing implemented in e-DPP are expressed by the following three 
categories; 
 

(1) Derated cable ampacity vs. load current 
(2) Voltage drop (%) at normal load operation 
(3) Voltage drop (%) at motor start (For motor loads only) 

 
The detailed procedures and formulas for power cable sizing are described below. 
 
 
13.2.7.1 Cable Ampacities 

"Temperature Factor" 
The temperature factor Fta is calculated with the approximation formula for each installation method 
("U/G" or "A/G") by the difference between the base and actual ambient temperatures of cable 
installation; 
 

TaTc
TTcFta

−
−

=  

 
Where 

Tc: Maximum conductor temperature  
Ta: Base ambient temperature 
T : Actual ambient temperature 
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The result of calculated Fta is referred by the cable sizing calculation and reflected to the overall 
"Derating Factor". 

"Grouping Factor" 
You can input grouping factor Fg for each cable installation type on the Criteria Page. The product of 
Fg and Fta becomes an overall derating factor. 

"Comparison with Load Current" 
The derated cable ampacity is compared with a load current multiplied by "Multiplying Factor MF" 
that can be inputted on the Other Page. 
 

[Cable Ampacity] * Fta * Fg > [Multiplying Factor (MF)] * [Load Current] 
 
If the above condition becomes true, then the program goes to the next step to calculate a voltage drop. 
If false, the next larger size of cable in the cable library will be examined. 
 
 
13.2.7.2 Voltage Drop at Normal Operation 
The calculation formula for the maximum length of cable against the specified voltage drop at normal 
running varies depending on the types of loads as follows. 
 
(1) 3-phase Motor 
 

( )θθ
ε
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V
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××
=  

 
Where 
l (m):  Maximum cable length (m) 
ε(%): Specified voltage drop (%) 
Vs (kV): System (bus) voltage (kV) 
I (A)  Motor full load current (A) 
r (ohm/km): Resistance of cable (ohm/km)  
x (ohm/km): Reactance of cable (ohm/km) 
cosθ:  Motor power factor at full load 
sinθ:  Motor reactance factor at full load 

 
(2) 1-phase Motor 
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ε
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=  

 
(3) 3-phase Static Load 
 

The calculation formula for the maximum cable length is given below by using KVA of a 
static load. 
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Where 
l (m):  Maximum cable length (m) 
ε(%): Specified voltage drop (%) 
Vs (kV): System (bus) voltage (kV) 
r (ohm/km): Resistance of cable (ohm/km)  
x (ohm/km): Reactance of cable (ohm/km) 
cosθ:  Power factor of static load at full load 
sinθ:  Reactance factor of static load at full load 

 
(4) 1-phase Static Load 
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=  

 
If the calculated l(m) is greater than or equal to the length of load cable, the program goes to the next 
step to calculate a voltage drop at motor start. 
If not, the next larger size of cable in the cable library will be examined. 
 
 
13.2.7.3 Voltage Drop at Motor Start 
The maximum cable length against the specified voltage drop (%) is calculated with the formula; 
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Where 

lS (m):  Maximum cable length (m) 
εS (%): Specified voltage drop (%) 
r (ohm/km): Resistance of cable (ohm/km)  
x (ohm/km): Reactance of cable (ohm/km) 
Z (ohm): Motor impedance at starting 
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Vm (kV): Motor rated voltage (kV) 
I (A)  Motor full load current (A) 
Is (%)  Motor locked rotor current (%) of I 
R (ohm): Motor resistance at starting 

SZR θcos×=  
X (ohm): Motor reactance at starting 

SZX θsin×=  
cosθS: Motor power factor at starting 
sinθS: Motor reactance factor at starting 

 
If the calculated l(m) is greater than or equal to the length of load cable, this cable size will be taken as 
a calculation result. 
If not, the next larger size of cable in the cable library will be examined. 
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13.3 Drum Scheduling 
Drum scheduling is a process of collecting identical cables (in terms of specifications and sizes) and 
allocating them into a spool called Drum.  A drum is a roll of cable of certain length. 
 
Procurement of cables is generally transacted in unit of drum.  And during the lay out (pulling) of 
cables at the construction site the cables are drawn out and cut from the drums.  For these reasons, a 
proper management of drum is necessary to facilitate procurement processes and to maximize the 
usage of the cable in the drums. 
 

 
 
The two main purpose of drum scheduling are; 
 
(1) Generate "Drum List" 

Drum list is a summary of cable drums which enlist pertinent information about the description of 
the drums.  Generally, this list is used for procurement 

 
(2) Generate "Drum Schedule" 

Drum schedule is a listing of arrays of cables allocated to a drum.  The arrays of cables represent 
the segments of the cable wound in the drums.  In other words, a drum schedule is a table of how 
the content of a drum will be cut into pieces/sections.  Generally, this schedule is used for 
construction. 

Flow of Drum Scheduling 
A cable schedule is necessary before drum list and drum schedules can be generated.  From the cable 
schedule, e-DPP collects all distinct cable sizes of distinct specification and summarizes them in table 
hereto referred as "Drum Specification".  A "Drum Specification" table also contains the criteria for 
the management of the length of cable that will be available in the drums for each distinct cable size of 
distinct specification. 
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Flow of Drum Scheduling 

 
 
13.3.1. Statistics 
This section conveys the information about the statistics of cables and drums utilized in the project. 

Specification 

Total number of specifications 
This refers to total counts of cables of distinct sizes and distinct specification. 

Drums 

Total number of drums 
This refers to the total counts of registered drums. 

Number of locked drums 
This refers to the total counts of protected drums (drums immune from changes). 

Cables 

Total number of cables 
This refers to the total counts of cables in the cable schedule. 

Number of cables scheduled 
This refers to the total counts of cables which were already scheduled to drum. 

Number of cables not scheduled 
This refers to the total counts of cables which are not yet scheduled to drum. 
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Number of locked cables 
This refers to total counts of protected cables (cables immune from changes). 
 
 
13.3.2. Drum Scheduling Functionalities 
The drum scheduling is divided with six functionalities as follows: 
 

Edit Drum Specifications 
Run Drum Scheduling 
Edit Drum List 
Edit Drum Schedule 
Move Drum Cables 
Check Cable & Drum Data 

 
 
13.3.2.1 Edit Drum Specification 
Clicking "Edit Drum Specification..." button brings out the summary of distinct cable sizes of 
distinct specification and the criteria for the management of the drum length (length of cable in the 
drum).  When this button is clicked, the following dialog appears; 
 

 
 
In the above dialog, you can specify the criteria for the management of the length of cable that will be 
available in the drums for each distinct cable size of distinct specification. 
 
(Note: In this version, the dialog shown above can now be minimized or maximized as desired by the 
user.) 

Table Properties 
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Option 
Select one of the two (2) options "Max. Len" or "Round Up". 

Max. Len 
If "Max. Len" is selected the maximum length of cable that will be available in a drum will be equal to 
the value specified in "Max. Length" column.  In other words, this option dictates the limitation of 
the summation of length of the segment of the cables that could be scheduled in a drum according to 
the fixed value in "Max. Length" column.  Also, the actual available spare length of cable in a drum 
may be equal to or greater than the value specified in "Spare Length" column. 

Round Up 
If "Round Up" is selected the maximum length of cable that will be available in a drum varies to the 
rounded-up value of the summation of the length of all segments of cables being scheduled in the 
drum but not more than the value specified in "Max. Length" column.  The rounding number is the 
value specified in "Round Up Length" column.  Also, the actual available spare length of cable in a 
drum may be equal to or less than the value specified in "Round Up Length" column. 
 
This option may be selected if excessive spare is not required for certain sizes of cables of certain 
specifications for some reason like for instance the cost per linear length of cable is high and/or the 
cable manufacturer accepts fractional order. 
 
Notes for both "Max. Len" and "Round Up" option 
 

a) The cumulative length of segments of cables that could be allocated to the drums is restricted by 
the "Scheduling Length".  "Scheduling Length" is the difference between the values in "Max. 
Length" and "Spare Length" column ("Max. Length" - "Spare Length"). 

b) In case a single (one segment) cable having a length more than the value specified in "Max. 
Length" column, this single cable will be allocated to a single drum of length equal to "Max. 
Length".  Though consideration can be taken later e.g. increase the drum length later or 
consider splicing the cable. 

Max. Length (m) 
This parameter is used to determine the prospective and limitation of length of cable that will be 
available in a particular drum.  By default, this parameter is populated with value from cable library 
if the corresponding data is available.  Otherwise, a default value of 1000(m) is set. 

Round-Up Length (m) 
This setting is valid only when "Round-Up" option is selected. The default value is 20 (m). Round-Up 
Length (m) should be less than 50% of Max. Length (m) and equal or less than Spare Length (m). 

Spare Length (m) 
Specify the prospective length of cable you want to spare in a drum.  The default value is 5% of 
"Max. Length (m)".  The actual drum spare length may be at least or at most equal to this value 
depending on the selected option "Max Len" or "Round Up" as discussed in "1) Option" above. 
 
The Spare Length (m) should be less than 50% of Max. Length (m). 

Scheduling Options 

All Max. Len… 
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Globally set the "Option" to "Max. Len" 

All Round Up… 
Globally set the "Option" to "Round Up" 

Drum Max. Length  
Globally assigned value to "Max. Length" according to the data entered in the text box. 

Update… 
Click "Update..." button to reflect the entered value in the adjacent textbox to the "Max. Length" 
column of the drum specification table 

Round Up Length 
Globally assigned value to "Round Up Length" according to the data entered in the text box. 

Update… 
Click "Update…" button to reflect the entered value in the adjacent textbox to the "Round Up Length" 
column of the drum specification table 

Spare Length 
Globally assigned value to "Spare Length" 

(m) - Update… 
Specify the absolute value of the intended spare length in the text box and click the adjacent button 
"Update…" to reflect the said value to the "Spare Length" column of the drum specification table. 

(%) - Update… 
Specify the intended spare length in percent of "Max. Length" in the text box and click the adjacent 
button "Update…" to reflect the absolute equivalent value of the said percentage value to the "Spare 
Length" column of the drum specification table. 

Command Buttons 

Update Table… 
When this button is clicked, the drum specification table will be updated based on the latest cable 
schedule i.e. new specification will be added if any and/or the counts of cables and their cumulative 
length (total length) will be updated if any relevant changes were made in the cable schedule.  All the 
user's defined setting and entry (i.e. data in the "Option", "Max Length", "Round Up Length", and 
"Spare Length" columns) will be unchanged. 

Remake Table… 
When this button is clicked, the drum specification table will be reset based on the latest cable 
schedule and the entire user's defined setting and entry will be overwritten with the default setting and 
data. 

Delete 
Delete a current row of drum specification which is not necessary anymore. Rows in which "No. of 
Cables" is more than zero are not allowed to delete. 
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Initial Sort 
Clicking this button returns the sort order to the original state when the dialog opens.  This is 
effective when the original sorting was re-organized by selective sorting.  Selective sorting is being 
done by clicking the header of a particular column on the table.  The order of sorting alternatively 
changes from ascending to descending and vice versa on subsequent click of the mouse at the header. 

Preview 
Click "Preview" button to view the print layout of the Table in its current state and print as necessary. 

Save 
Click "Save" button to save the changes made. 

To Excel 
Click "To Excel" button to export the Table in its current state to MS Excel. 

Close 
Click "Close" button to return to "Drum Schedule" dialog. 
 
 
13.3.2.2 Run Drum Scheduling 
Clicking "Run Drum Scheduling…" button brings out the dialog responsible for creating the "Drum 
List" and "Drum Schedule".  When this button is clicked, the following dialog appears; 
 

 

Scheduling Objects 
Select from the pull down lists which cables of certain size of certain specification are the target of 
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scheduling.  The list of cable specification available for scheduling is shown in the "List of Cable 
Specification" list box.  If the target are all the cables, leave all the pull down list to "All".  The 
pull-down lists behave in hierarchical order i.e. from top to button. 

Data Source 
Select the Data Source of the target cables.  Data Source is a name of cable manufacturer 
(MFRName) in e-DPP cable library and intended to use for discriminating the cable data when 
different cable manufacturers are selected with identical specification of cables. 
 
When the cable data are not extracted from e-DPP cable library, Data Source list shows a blank.  This 
occurs if the name of manufacturer is not specified when the cable data have been populated by User 
Data Import or Data Filling action.  However, even in such case, the drum scheduling program treats 
those cables as "Manufacturer name = <blank>" in the same manner as for the other cables. 

Conductor Type 
Select the conductor type (copper or aluminum) of the target cables. 

Rated Voltage 
Select the rated voltage of the target cables. 

Cable Type 
Select the insulation, jacket, mechanical, and/or chemical protection type of the target cables. 

No. of Wires 
Select the number of conductors and their configuration of the target cables. 

Cable Size 
Select the size of the target cables. 

Geographical Criteria 
The Geographical Criteria accounts the relationship of the pulling locations and the equipment to be 
served.  These criteria allow you to optimize your scheduling preparation by automatically putting 
cables to the right drums.  There are two (2) methods to realize an optimal drum scheduling; 
 

i. Filter the prospect cables for drum scheduling by "Geographical Criteria". 
ii. Use the "Orphan Control" 

 
When "Geographical Criteria" is applied, it is required to manually execute one by one each group of 
target cables (group of cables of the same location).  On the other hand, "Geographical Criteria" has 
an advantage.  For example, in case engineering work in some areas is delayed due to some reasons 
but in some areas it is already complete and for those completed areas placement of order of the cables 
is now required, then "Geographical Criteria" may be the best option. 

Site Area 
Select the site area where the target cables belong. 

Substation 
Select the substation where the target cables belong. 
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Process Unit 
Select the process unit where the target cables belong. 

Switchboard 
Select the switchboard where the target cables are served. 

Bus 
Select the bus where target cables are terminated. 

Options 

Scheduling Scope 
The following options are effective at the second and subsequent runs.  Either the cables that have 
been already scheduled to drums or the cables that have not been yet can be target of scheduling. 

All cables with & without drum no 
If this option is selected all cables and drums will be the target of scheduling. 

Only cables without drum no 
If this option is selected only the cables which have not been scheduled yet to drums will be the target 
of scheduling. 

Include existing drums 
This is an additional option to take into account the spare lengths of the existing drums, meaning if a 
particular cable with certain length can fit in the available spare length of a certain existing drum then 
this cable will be scheduled to that drum. 

Orphan Control 
The objective of these Options is to globally optimize scheduling preparation by automatically putting 
cables to the right drums. 
 
Note: The following options (one or more) are enabled only when their counterpart (pull down list) in 
the "Geographical Criteria" frame is set to "All" and the subject addressed by the said option is not 
utilized in the Drum Naming Convention Builder. 

Site Areas 
Check this checkbox to segregate scheduling of cables by site area. 

Substations 
Check this checkbox to segregate scheduling of cables by substation. 

Process Units 
Check this checkbox to segregate scheduling of cables by process unit. 

Switchboards 
Check this checkbox to segregate scheduling of cables by switchboard. 
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Buses 
Check this checkbox to segregate scheduling of cables by bus. 

Drum No. - Naming Convention 
Specified Naming Convention will be displayed on this area. 

"Edit" Button 
Click "Edit" button to bring out the Drum Naming Convention as shown below. 
 

 
 
The drum naming convention is a rule how the drums will be assigned with ID (Drum Number) 
automatically. 

Source of Naming Fragment 
The following tables and fields serve the criteria to produce the intended format of the Drum Number.  
 

Tables  Fields 
Cond Type Site Area  User Text 1 
Rated Voltage Substation  User Text 2 
Cable Type Process Unit  User Text 3 
#Wire Switchboard  Serial Number 
Unit Bus   
Cable Size    

 
The contents (records) of each table are dynamic with the Cable Schedule (meaning their value 
depends on what is available in the Cable Schedule). 
 
In each table are records of "Value" & "Code".  The data in the column "Value" is data extracted from 
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Cable Schedule and the data in the column "Code" is default or user-defined data that will represent 
the "Value".  Hence, the combination of the "Code" is actually the one that comprises the Drum 
Number. 
 
e-DPP pre-assigned default abbreviation for the "Code" but the user can later freely assigned any 
alphanumeric up to 10 characters to yield meaningful message.  However, the drum number is 
limited only up to 26 characters and therefore selection of the Codes and their combination should be 
exercised thoroughly in order for the resulting drum number not to exceed the said limitation. 

Cond Type 
This table corresponds to the type of conductor of the cables.  The value of "0" and "1" denotes 
copper and aluminum respectively.  The default Code is "CU" for "0" and "AL" for "1". 

Rated Voltage 
This table corresponds to the rated voltage of the cables.  The default Code for each Value is set to 
alphabet letter. 

Cable Type 
This table corresponds to the type of insulation, jacket, and other mechanical or environmental 
protection of the cables.  The default Code for each Value is set to alphabet letter. 

#Wire 
This table corresponds to the number of conductors in the cables. The default Code is set as to the 
number of conductors in two digits format.  For example if the number of conductor is 3, then the 
corresponding default Code is "03". 

Unit 
This table corresponds to the configuration of the conductors in the cables, e.g. Core (C) or Pair (P). 
The default Code is set as same as the Value. 

Cable Size 
This table corresponds to the size of the cables. The default Code is set as same as the Value with the 
following exception; 
 

i) Slash ("/") used in AWG size series like in "4/0" or "2/0" is designated to "S" since this 
symbol is not allowed by the program to be included in the drum number.  For example, the 
Code for "4/0" is defaulted to "4S0". 

ii) Dot (".") used in metric size series like in "2.5" is designated to "D" due to the same reason 
as in i).  For example, the Code for "2.5" is defaulted to "2D5". 

Site Area, Substation, Process Unit, Switchboard, Bus 
These tables correspond to the geographical location of the cables where they will be laid out.  Their 
title explains their scope.  The default Code for each Value of each table is set to alphabet letter. 

User Text 1, User Text 2 & User Text 3 
Any static strings (alphanumeric and hyphen) which is required to be part of the drum number may be 
entered here. 
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Serial Number 
Serial number is a part of drum number that makes a drum number unique in case there is more than 
one drum of identical specifications (having cable with the same specification).  This number 
corresponds to the count of drums.  Therefore, it is a must to have this number.  Number of digits 
from 1 to 5 is available as option for user to choose.  The numbers of digits dictate the number of 
digits of the serial number and it signifies the number of leading zeros less the digits of the count of a 
particular drum.  For example, if you selected number of digits of 4 and the count of a particular 
drum is 32, then the serial number will be "0032".  In case user has chosen number of digits less than 
the number of digits of the count of a particular drum, the exact number of the count will be utilized.  
But the presentation of those counts which exceed and those which are within the chosen number of 
digits will be different.  For example, if the chosen Number of Digits is 3, all counts less than 1000 
will be presented in 3 digits (001 to 999) and those 1000 and above will be presented in more than 3 
digits (1001 to ? ). 

"Clear All" Button 
Clicking on this button resets all the settings to default pre-assigned setting. "Convention Builder" is 
reset as well and only "Serial Number - 3 Digits" remains. 

Convention Builder 
There are Ten (10) sections in the "Convention Builder" frame and combination of these sections will 
comprise the Drum Numbers.  Each section needs to be filled-in from any of the 15 items in the 
"Source of Naming Fragment" frame by drag and drop operation. 
 

Notes:  
i. Each item in the "Source of Naming Fragment" can only be used once in the "Convention 

Builder". 
ii. At least one section in the "Convention Builder" is should be filled-in by "Serial Number" 

from the "Source of Naming Fragment". 

"Clear 1" to "Clear 10" Button 
Clicking this button clears the section (textbox) underneath.  Empty sections are eliminated after 
execution of "Save" button and reopening of the dialog. 

"-" (Hyphen) 
Check the checkbox above the hyphen label to inserts a hyphen between the adjacent sections. 

Sample (Max. 26 char) 
A sample of the drum number is reflected here for reference.  It shows dynamically the format of the 
drum number related to the product of the convention builder. 
 
As the maximum length of drum number is limited to 26 characters, this textbox will help you 
distinguish if you exceed such limitation. 

"Save" Button 
Click "Save" button to save the changes made. 

"Close" Button 
Click "Close" button to return to "Run Drum Scheduling" dialog. 
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Command Buttons 

Clear All 
Click "Clear All" button to delete the drum list and all drum schedules. 

Run 
Click "Run" button to execute drum scheduling. (Confirmed if desired to open drum list editor) 

Close 
Click "Close" button to return to main dialog. 
 
 
13.3.2.3 Edit Drum List 
Clicking "Edit Drum List…" button brings out the Drum List Editor dialog as shown below.  
Alternatively, this dialog can be opened immediately after the execution of Drum Scheduling. 
 

 
 
In the above dialog, "Lock", "Drum Length (m)", "PO No." and "Maker" columns may be edited. 
 
(Note: In this version, the dialog shown above can now be minimized or maximized as desired by the 
user.) 

Table Properties 

Lock 
Checking "Lock" cell protects the drum and its contents (cables) against changes when the drum 
scheduling is re-executed. This function is useful to mark the drums that have been already ordered to 
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manufacturer. 

Drum Length (m) 
Alter the drum length as necessary. 

PO No. & Maker 
You may enter any data in "PO No." and "Maker" columns for additional information. 

Command Buttons 

Lock All & Unlock All 
Check or uncheck all the cells in the "Lock" column in one step. 

Show New Drum No. & Hide New Drum No. 
Clicking "Show New Drum No." button shows "New Drum No." column in the table where you can 
enter a new drum number. Note that the new drum number should be unique and up to 26 character 
long only. 

Create New Drum 
Click "Create New Drum" button to create a new drum to which unscheduled cables may be scheduled 
manually. 
 

 

New Drum No. 
Enter a new unique drum number up to 26 characters 

Data Source 
Select the Data Source that the drum will cater. 

Conductor Type, Rated Voltage, Cable Type, No. of Wires, Cable Size, & Drum Length 
(m) 
These parameters describe the specification of the new drum.  Select the appropriate parameters. 
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Delete Drum 
Click "Delete Drum" button to delete the currently selected drum. Note that only empty drums (no 
scheduled cables) can be deleted. 

Filter / Unfilter 
Click "Filter" button to perform filter by selection.  The currently selected cell serves as the filtering 
criteria.  Click "Unfilter" button to restore the table. 

To Excel 
Click "To Excel" button to export the Table in its current state to MS Excel. 

Preview 
Click "Preview" button to view the print layout of the Table in its current state and print as necessary. 

Save 
Click "Save" button to save the changes made. 

Close 
Click "Close" button to return to "Run Drum Scheduling" dialog. 
 
 
13.3.2.4 Edit Drum Schedule 
Click the "Edit Drum Schedule…" button if you want to edit some data in some cables (data which has 
relevance to geographical information only).  This action will open the following dialog; 
 

 

List of Cable Specifications 
Select from the list of the cable specification you wish to modify. 
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List of Drum No. (＊:Locked) 
The drums bearing the specification selected in the "List of Cable Specification" are shown here.  In 
this list, select the drum number where the cable you wish to modify belongs. 

Spec. Info. 
The "No. of Drums", "No. of Cables", and "Total length" involved in the selected specification on 
"List of Cable Specifications" are shown in this frame for information. 

Drum Info. 
Relevant information of the Drum selected in the "List of Drum No." is shown in this frame. 

Spread Table 
The scheduled cables in a particular drum selected in "List of Drum No." are shown here.  Here you 
can edit the cable literature like, "Lock", "Length (m)", "From", "To", "Site Area", "Substation", 
"Process Unit", "Switchboard", and "Bus". 
 
If the length of some cables is increased and in total exceeds the drum length, an alert message will 
warn you.  You can either shorten the length of some cables to meet the drum length (but seems not 
appropriate) or just note the message and save the changes and later move some cables to other drums. 

Command Buttons 

Lock All & Unlock All 
Check or uncheck all the cells in the "Lock" column in one step. 

Preview 
Click "Preview" button to view the print layout of the Table in its current state and print as necessary. 

Save 
Click "Save" button to save the changes made. 

Close 
Click "Close" button to return to main dialog. 

To Excel 
Click "To Excel" button to bring out the option dialog as shown below and eventually export drum 
schedule(s) to MS Excel. 
 
Note: 
"Site Area", "Substation", "Process Unit", "Switchboard", and "Bus" columns are now available when 
exporting Cable Drum Schedule on MS Excel by "To Excel" button. Such columns were initially 
hidden upon exporting. When the user would like to include those columns, "Unhide" MS Excel 
function must be used. (Select both the boundary columns, right-click and select "Unhide".)  



Cable Management  Drum Scheduling 

ELTECHS Engineering & Consulting Co., Ltd. 13-49 e-DPP 3.0 
 

 

Select scope 

All drums of all cable specifications 
All the drums existing in the current drum schedule will be exported to MS Excel. 

All drums of current cable specification 
All the drums of the currently selected cable specification in "Drum Schedule - Edit" dialog will be 
exported to MS Excel. 

Current drum 
Only the drum currently selected in "Drum Schedule - Edit" dialog will be exported to MS Excel. 

Advanced 
Select this option then select from the pull down list the conditions on what to export to MS Excel.  
Each item is combined with AND operator. 

Options 

Cable ID Field 
Select a desired field from the drop down list to be shown in the MS Excel sheets on "Cable No." 
column. 
 
(Note: Options are the naming conventions created by the user on user defined fields to cover all 
possible project requirements.) 

Page break per drum no. 
Check this checkbox to inserts a page break per drum number in MS Excel sheets. 
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13.3.2.5 Move Drum Cables 
Click "Move Drum Cables…" button if you want to manually move some cables from one drum to 
another due to some reasons.  This action will open the following dialog; 
 

 
 
As mentioned above, in this dialog, cables can be moved from one drum to another drum of same 
specification (same cable specification).  Movement is done by drag & drop or arrow button 
operation.  Neither "Lock", "Cable ID", "Length (m)", "Site Area", "Substation", "Process Unit ID", 
"Switchboard" nor "Bus" parameters can be edited in this dialog.   

Cable Specifications 
Select a cable specification from this pull down list.  Think of this "Select Cable Specification" pull 
down list as a filter criterion for the Drums.  Meaning the drums that will be shown in the "Drum 
Data (1)" and "Drum Data (2)" panes have a cable specification as the selected one in the "Select 
Cable Specification" pull down list. 

Drum Data (1) & Drum Data (2) 
The dialog is generally divided into two (2) panes, the "Drum Data (1)" pane and the "Drum Data (2)" 
pane.  Both panes contain the same drums (drum no.) and a virtual drum named "<None>".  This 
"<None>" drum en-houses all unscheduled cables.  By manipulation of drum selections in the "Drum 
Data (1)" pane and in the "Drum Data (2)" pane, you will be able to move cables from one drum to 
another in both directions. 

Movement by Drag & Drop Mouse Operations 
I. To move cables by Drag & Drop operations from one to another drum: 
 

a) Select the specification of cable you wish to move in the "Select Cable Specification" pull down 
list.  The drums having that specification will be listed in the Drum Data (1) & (2). 
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b) On Drum Data (1), select the drum number having the cable(s) you wish to move. 
 
c). On Drum Data (2), select the drum number where you wish to move the cable. 
 
d). On the Drum Data (1) point to the Cable ID and drag & drop to the cable list section of the 

Drum Data(2). 
 
e). Moved Cable ID from Drum Data (1) will be displayed on this area. 

 

 
 
Note: 
i)  Process of moving of Cable ID stated above can be done also from Drum Data (2) to Drum 

Data (1). 
 
 

II. To move more than one cable at once: 
 

a) Select the specification of cable you wish to move in the "Select Cable Specification" pull down 
list.  The drums having that specification will be listed in the Drum Data (1) & (2). 

 
b) On Drum Data (1), select the drum number having the cable(s) you wish to move. 
 
c). On Drum Data (2), select the drum number where you wish to move the cable(s). 
 
d) On Drum Data (1), point to the row headers (the cells under "No" column) of the starting cable 

and drag to ending cable you wish to move.  The highlighted cables are subject to move. 
 
e) Click ">>" button. 
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Note: 
i)  Only adjacent cables can be selected. 
ii) If you want to select all cables, click the "No" cell (upper-left most corner cell) 
iii) Process of moving of Cable ID(s) stated above can be done also from Drum Data (2) to 

Drum Data (1). 

Don't show message 
Check "Don't show message" checkbox to disable the warning message box which keeps on warning 
you whenever the total length of cable scheduled in a certain drum exceed the drum length as result of 
the moving cable to other drums. 

Save 
Click "Save" button to save the changes made. 

Close 
Click "Close" button to return to main dialog. 
 
 
13.3.2.6 Check Cable & Drum Data 
By virtue of editing cables outside of Drum Scheduling program (e.g. in Cable schedule), 
inconsistency in the structure of the drum schedules and drum list may occur.  For example: 1) 
Cables of certain specification might be assigned to drums of different specification, 2) New drums 
might be specified in cable schedule though do not exist in the drum list.  e-DPP can detects these 
two (2) cases of inconsistency. 
 
Click "Check Cable & Drum Data…" button to check the said inconsistency.  This action will open 
the following dialog; 
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Inconsistent Specifications 
This area enlists the drums and their contents having disagreement between the specification of the 
drums themselves and the specification of one or more cables assigned to them.  The inconsistent 
parameters are highlighted in red color. 
 
It is a must to resolve the inconsistency by correcting the relevant items in the cable schedule or 
re-execute drum scheduling (either manually un-schedule from the drum the inflicted cables or re-run 
drum scheduling). 

Preview 
Click "Preview" button to view the print layout of the complete list of cables (where the specification 
of one or more cables are inconsistent against the drum specification) belonging to the currently 
selected drum and print as necessary. 

New Drums 
This area enlists the drums that exist in the cable schedule but do not exist in the drum list.  This 
situation happens when user entered certain drum numbers not registered in the drum list in the cable 
schedule. 
 
Check the checkbox adjacent to the drum number to qualify them for addition to the drum list 

"Add to Drum List" Button 
Click "Add to Drum List" button to add the checked new drums to the drum list. 
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13.4 Conduit and Gland Sizing 
The conduit and cable gland sizing can be performed for all or part of cables (power, control, etc.) 
stored in the cable schedule provided these cables have a counterpart in one of the Cable Libraries. 
In order to perform the sizing, "Conduit and Cable Gland Selection Table" needs to be created 
beforehand in the menu "Defaults - Conduit and Gland Size".  Also, under the "Conduit and Cable 
Gland Selection Table" window environment it is important for each newly selected cable library (or 
already selected but no prior commencement of clicking the "Edit" button yet) the "Edit" button is 
clicked in order e-DPP program could generate the corresponding conduit and gland selection table 
which will be referred by the Conduit and Gland sizing.  Otherwise, the Conduit and Gland Sizing 
program will not yield the expected results.  Refer to Chapter 13, clause 13.8.2 (Command Buttons) 
for more information. 
 
The data that are actually filled out by this program are; 

Conduit Type 
Conduit Size 
Cable Gland Type 
Cable Gland Size 
Cable Entry (Thread) Type 
Cable Entry (Thread) Size 

 
When the following key parameters match "Conduit and Gland Selection" table and the cable schedule, 
the above listed 6 parameters are transferred from the former to the latter. 

Cable Manufacturer Name 
Cable Voltage 
Cable Type 
No. of Cores 

 
<Note> 
The conduit sizing can be performed for single cable only that is installed in a conduit. Multiple cables 
installed in a conduit cannot be treated. Therefore, "Percentage of Cross-Section" for single conductor 
only in "Conduit and Gland Selection" table dialog is valid for the conduit sizing.  
 
 
13.4.1 Entrance Menu 
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Targets 

All Cables 
All cables (Power, Control, Communication, etc.) stored in the cables schedule become targets of the 
sizing. 

Power Cables 
Only power cables stored in the cables schedule become targets of the sizing. 

Blank Data Only 
Cable data where their conduit and cable gland type/size are not yet filled become targets of the sizing. 
The existing non-blank data are bypassed. 

All Data 
Both blank and non-blank data become targets of the sizing. 
 
 
13.4.2 Results 
You can confirm the results of conduit and cable gland sizing on the edit windows of cable schedule 
(DPPCable1 and DPPCable2). 
 

 
 
The entry thread types which have been filled from Project Default Data - Cable Entry will be 
overwritten by the results of conduit and gland sizing program. 
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13.5 Cable Summary 
The Cable Summary tool allows you to generate report of all the cables utilized in your project.  The 
summary is in terms of the quantities of the cables. 
 

 
 
 
13.5.1 Cable Summary Criteria 

Rated Voltage 
Select the rated voltage of the cables of interest as one of the criteria of the summary. 

Type 
Select the type of insulation/jacket of the cables of interest as another criterion of the summary. 

# of Conductors 
Select the number and unit of construction of the conductors of the cables of interest as another 
criterion of the summary. 

Size 
Select the size of the cables of interest as another criterion of the summary. 
 
Note: The items appearing on the list box of Rated Voltage, Type, # of Conductors, and Size are 
limited by data available in the cable schedule. 
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13.5.2 Command Button 

Help 
Click on "Help" button to open On-Line help file. 

Run Summary 
Click on "Run Summary" button to generate the cable summary according to the criteria discussed in 
clause 16.2.1.  The resulting summary is shown underneath of the window in tabular view. 

Preview 
Click on "Preview" button to show the printable layout of the generated summary. 

Preview Toolbar 
 

 

Next 
Click on "Next" button to navigate to next page (grayed-out if the preview contains only one page or if 
the preview is on the last page). 

Previous 
Click on "Previous" button to navigate to previous page (grayed-out if the preview contains only one 
page or if the preview is on the first page). 

Zoom 
Click on "Zoom" button to zoom-in or zoom-out and vice versa the size of the preview layout. 

Print 
Click on "Print" button to bring up the Print dialog box to start and print job.  On the Print dialog box, 
the Setup dialog box can also be called upon through "Page Setup" command button. 
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Setup 
Click on "Setup" button to display the Setup dialog box which contains options that allow you to setup 
the printing preferences. 

Close 
Click on "Close" button to close and return to Cable Summary Dialog. 

To Excel 
Click on "To Excel" button to output directly the cable summary in an external MS-Excel file.  To 
save a copy, select File→Save-as in the MS-Excel environment and assign a new file name. 

Cancel 
Click on "Cancel" button to close the Cable Summary Dialog window. 
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13.6 Gland Summary 
The Gland Summary tool allows you to generate report of the entire gland utilized in your project.  
The summary is in terms of the quantities of the glands. 
 

 
 
 
13.6.1 Gland Summary Criteria 

Gland Type 
Select the type of the glands of interest as one of the criteria of the summary. 

Gland Size 
Select the size of the glands of interest as another criterion of the summary. 

Entry Type 
Select the entry type of the glands of interest as another criterion of the summary. 

Entry Size 
Select the entry size of the glands of interest as another criterion of the summary. 
 
Note: The items appearing on the list box of Gland Type, Gland Size, Entry Type, and Entry Size are 
limited by data available in the cable schedule. 
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13.6.2 Command Button 

Help 
Click on "Help" button to open On-Line help file. 

Run Summary 
Click on "Run Summary" button to generate the cable summary according to the criteria discussed in 
clause 16.2.1.  The resulting summary is shown underneath on tabular view. 

Preview 
Click on "Preview" button to show the printable layout of the generated summary. 

Preview Toolbar 
 

 

Next 
Click on "Next" button to navigate to next page (grayed-out if the preview contains only one page or if 
the preview is on the last page). 

Previous 
Click on "Previous" button to navigate to previous page (grayed-out if the preview contains only one 
page or if the preview is on the first page). 

Zoom 
Click on "Zoom" button to zoom-in or zoom-out and vice versa the size of the preview layout. 

Print 
Click on "Print" button to bring up the Print dialog box to start and print job.  On the Print dialog box, 
the Setup dialog box can also be called upon through "Page Setup" command button. 
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Setup 
Click on "Setup" button to display the Setup dialog box, which contains options that allow you to 
setup the printing preferences. 

Close 
Click on "Close" button to close and return to Cable Summary Dialog. 

To Excel 
Click on "To Excel" button to output directly the cable summary in an external MS-Excel file.  To 
save a copy, select File→Save as in the MS Excel environment and assign a new file name. 

Cancel 
Click on "Cancel" button to close the Cable Summary Dialog window. 
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13.7 Minimum Cable Size 
The Minimum Cable Size Table (DPPMinCabSize) defines the minimum cable size for each output 
(kW or HP) of LV, MV and HV motor. If the results of cable sizing routine (refer to Chapter 13.1, 
Power Cable Sizing.) show smaller cable sizes than those defined in DPPMinCabSize, the calculated 
cable sizes are replaced with the minimum cable sizes defined in DPPMinCabSize. (There is an 
option switch to do so or not.) 
 
Only one DPPMinCabSize is created for all applicable motor voltage classes (LV-1 (3Ph), LV-2 (3Ph), 
LV (1Ph), MV1, MV2, HV1 and HV2) together. However, only the voltage classes that have been set 
to non-zero values in "Project Information" (see Chapter 8, Project Menu) are effective for creating 
DPPMinCabSize. The other ineffective voltage classes will be disabled to select by a user. 
 
 
13.7.1 Entrance Menu 

 

Motor Output Unit 
Select Motor Output Unit either "HP" or "KW". 

Cable Size Unit 
Select Cable Size Unit either "Metric" or "English". 

Conduit Size Unit 
Select the Conduit Size Unit, "Metric" or "English". 

Cable Data 
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Applicable Standard 
The standard applicable to cables selected in "Project → Standard" menu is shown in this cell. 

Rated Voltage 
Cable rated voltage corresponding to the active "Motor Voltage Class" selected in "Project → 
Electrical" menu is shown in this cell. 

Motor Voltage Class 
Selects one of the motor voltage classes that have been defined in "Project Information" for which a 
part of DPPMinCabSize is being edited. Only one class can be selected at a time. 
When the corresponding records already exist, e-DPP immediately enters an edit mode. The check 
boxes indicating existence of data are shown in the right area of each motor voltage class. 

Material Types 

Cable Manufacturer 
The uniquely filtered values of the cable manufacturer field in the cable library appear on the selection 
box. The default value initially shown is "DPP". 

Cable Type 
The values of cable type field in the cable library are shown on the selection box. 

Conduit Type 
All the values of the conduit type field in the conduit library appear on the selection box. 

Gland Type 
All the values of the cable gland type field in the cable gland library appear on the selection box. 

Cable Entry Type 
The value list for the cable entry type field in the cable gland library is used for selection of this item. 
("M", "NPT", "PG", "PF" and "ET") 
A default value shown on the box is the previously selected one in "Project Information". 

Minimum Size Calculation By Fault Current 

Cable Conductor Type 
Select the type of cable conductor either "Copper" or "Aluminum" which is used to calculate the 
minimum cable size to withstand a fault current input below. 
When "Motor Voltage Class" is LV-1 (3Ph), LV-2 (3Ph) or LV (1Ph), this item is disabled to select. 

Standard 
Select Cable Standard either "IEC" or "JIS" which is used to calculate the minimum cable size as well. 
When "Motor Voltage Class" is LV-1 (3Ph), LV-2 (3Ph) or LV (1Ph), this item is disabled to select. 

Insulation Material 
All the values of cable insulation materials filtered with "Conductor Type" and "Standard" specified 
above are indicated in the selection box. Select one of them, which is used to calculate the minimum 
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cable size as well. 
When "Motor Voltage Class" is LV-1 (3Ph), LV-2 (3Ph) or LV (1Ph), this item is disabled to select. 

Fault Clearing Time (sec) 
Enter a numeric value in the range of 0 - 1.0 (sec) which is used to calculate the minimum cable size 
as well. 
When "Motor Voltage Class" is LV-1 (3Ph), LV-2 (3Ph) or LV (1Ph), this item is disabled to enter. 

Fault Current (kA) 
Enter a numeric value in the range of 0 – 100 (kA) which is used to calculate the minimum cable size 
as well. 
When "Motor Voltage Class" is LV-1 (3Ph), LV-2 (3Ph) or LV (1Ph), this item is disabled to enter. 

"Calc" Button 
When this button is clicked, "Calculated Min. Size (mm2)" is calculated and its result is shown. 

"Clear" Button 
When this button is clicked, the input fields "Fault Clearing Time (sec)", "Fault Current (kA)" and 
"Calculated Min. Size (mm2)" are cleared. 

Calculated Min. Size (mm2) 
The program calculates this value with the following formulas and shows its result on the text box, 
which is disabled to edit; 
 
"Calculated Min. Size (mm2)" 

= 1000 * "Fault Current (kA)" * sqrt ("Fault Clearing Time (sec)") / [Coefficient] 
 
Coefficient is stored in the e-DPP system database. 

"Edit" Button 
When "Edit" button is clicked, another window as shown in Section 13.7.2 appears for editing switch 
devices, the minimum cable sizes, conduit sizes and gland sizes of the selected motor voltage class. 

"Delete" Button 
When "Delete" button is clicked, all the records of the minimum cable sizes belonging to the selected 
motor voltage class are deleted from DPPMinCabSize. A warning message appears for your 
confirmation before deletion is taken place. 
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13.7.2 Editor 

 
 
Editing the minimum cable sizes is performed on the above form. The upper area of the form indicates 
the field contents input in the entrance menu. The lower area indicates the field contents of table 
DPPMinCabSize. 

Switch Device 
Select from Fuse, CB or MCCB (for future). 

Cable Size 
If you like to change the minimum cable size, select the other size from the list box. 
If the calculated minimum cable size is effective (MV-1, MV-2, HV-1 & HV-2) and an newly selected 
size is less than that, a warning message is shown. 

Conduit Size 
When new records are created in DPPMinCabSize or "Conduit Type" changes from the previous one, 
the conduit size (record) corresponding to the minimum cable size is retrieved as an initial value from 
the conduit library with the following criteria; 
 
Minimum conduit size (minimum Inner Diameter) that satisfies; 
 

[Inner Diameter] **2 >= [Cable O.D.] **2 / [Ratio of Cross Section for One Conductor] 
 
"Ratio of Cross Section" can be referred or changed in the entrance menu of the Conduit & Cable 
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Gland Selection Table. (See Section 10.4.1, Entrance Menu.) 
 
When the corresponding record is not found in the cable or conduit library, the conduit size will be left 
blank. 
 
If you like to change the calculated conduit sizes, select the other size from the list box. 

Gland Size 
When new records are created in DPPMinCabSize or "Gland Type" changes from the previous one, 
the gland size (record) corresponding to the minimum cable size is retrieved as an initial value from 
the cable gland library with the following criteria; 
 
Minimum gland size (minimum Cable O.D. Max for Gland) that satisfies; 
 

[Cable O.D. Max for Gland] >= [Cable O.D.] 
 
When the corresponding record is not found in the cable or gland library, the gland size will be left 
blank. 
 
If you like to change the calculated gland sizes, select the other size from the list box. 

Entry Size 
When new records are created in DPPMinCabSize or "Entry Type" changes from the previous one, 
the entry size of gland (record) corresponding to the selected gland type/size and entry type is 
retrieved as an initial value from the cable gland library. 
 
"Entry Size" is indication only and not editable. Values of "Entry Size" are always synchronized with 
"Gland Size" of the same records. 

"Re-Calc" Button (Not available) 
When "Re-Calc" button is clicked, "Conduit Size" and "Gland Size" are newly selected as per the 
above-described formulas. This function is used when you change the minimum cable sizes manually. 
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13.8 Conduit and Gland Size Table 
The Conduit & Cable Gland Selection Table (hereinafter called "Conduit Selection Table") defines 
default sizes of conduits, entries and cable glands against each size of power cable and is used for the 
conduit & cable gland sizing routine. For such, that the detailed procedure is described in Chapter 13, 
Cable Management. 
The information similar to this Conduit Selection Table exists in the minimum cable size table 
DPPMinCabSize [Conduit Size], [Entry Size] and [Gland Size] that are indexed by motor output 
kW and forms a subset of the Conduit Selection Table. The difference between these 2 tables is that 
whilst the Conduit Selection Table may includes any type and any size of cables used for a project, the 
minimum cable size table may not. 
 
The table name for the Conduit Selection Table is DPPCGSelect. 
 
 
13.8.1 Entrance Menu 

 

Cable Size Unit 
Select Cable Size Unit either "Metric" or "English". 

Conduit Size Unit 
Select the Conduit Size Unit, "Metric" or "English". 

Cable Standard 
Select the Cable Standard, IEC, ANSI or JIS. 

Cable Manufacturer 
The uniquely filtered values of the cable manufacturer field in the cable library appear on the selection 
box. The default value initially shown is "DPP". 
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Cable Voltage 
The uniquely filtered values of the cable voltage field in the cable library appear on the selection box. 

Conduit Type 
All the values of the conduit type field in the conduit library appear on the selection box. 

Entry Type 
The value list for the cable entry type field in the cable gland library is used for selection of this item. 
("M", "NPT", "PG", "PF" and "ET") 
A default value shown on the box is the previously selected one in "Project Information". 

Gland Type 
All the values of the cable gland type field in the cable gland library appear on the selection box. 

Percent of Cross - Section 
Enter the maximum allowable ratios (%) of the cable cross sectional areas against the inner sectional 
areas of conduit for 3 cases of one, two and more than two conductors installed in a conduit. 
Each value has to be within the range of over 0 to 100 (%) (Zero is not allowed.). The default figures 
shown here are retrieved from NEC (53% for one conductor, 31% for two conductors and 40% for 
more than two conductors.). 
 
Click the "Save" buttons if you wish to save the changes made in the percent of cross section if any. 

"Cable Library ⇔ Selection Table" 
The cable types in the cable library filtered with the upper parameters are shown on the left-hand 
selection box. You can select anyone from them to create or add to the Conduit Selection Table and 
move it to the right-hand selection box showing the present contents of the Conduit Selection Table. 
When content is removed from the right-hand box, all the corresponding data are deleted from the 
Conduit Selection Table with a warning message. 
 
 
13.8.2 Command Buttons 

Edit 
Click "Edit" button for each cable library placed to the "Selection Table" pane in order for e-DPP to 
initially perform the conduit and gland sizing (according to the parameters set at the upper half portion 
of the dialog window) for each cable size belonging to the said cable library.  Eventually, e-DPP 
generates the "Conduit and Gland Selection Table" for that particular cable library.  Only one selected 
item can be edited at a time. 
 
Once the "Edit" button is clicked, another window as shown in the next Section 10.4.3 will appear.  
The user can manually modify then the conduit and gland sizes which were initially filled-up by 
e-DPP program according to his preference. 
 
Note:  Clicking the "Edit" button for each new cable library placed in the "Selected Table" pane or 
already existing but no prior commencement of clicking the "Edit" button yet is a must prior to 
Conduit and Cable Sizing activity. 
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Help 
Click on "Help" button to open On-Line help file. 

Close 
Click on "Close" button to close the Conduit and Cable Gland Selection Table Dialog window. 
 
 
13.8.3 Editor 

 
 
Editing the Conduit Selection Table is performed on the above form. The upper area of the form 
indicates the field contents input in the entrance menu. The lower area indicates the field contents of 
table DPPCGSelect. 

Available 
This field is linked to the same one of the cable library. Even if this checkbox is unchecked, the 
Conduit Sizing program regards this cable as target. 

Conduit Size - 1 Conductor 
When new records are created in DPPCGSelect or "Conduit Type" changes from the previous one, the 
conduit size (record) corresponding to the individual cable size is retrieved as an initial value from the 
conduit library with the following criteria; 
 
Minimum conduit size (minimum Inner Diameter) that satisfies; 
 

[Inner Diameter] **2 >= [Cable O.D.] **2 / [Ratio of Cross Section for One Conductor] 
 
When the corresponding record is not found in the cable or conduit library, the conduit size will be left 
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blank. 
 
If you like to change the calculated conduit sizes, select the other size from the list box. 

Conduit Size - 2 Conductors 
The following formula is applied: 
 

[Inner Diameter] **2 >= [Cable O.D.] **2 / [Ratio of Cross Section for Two Conductors] 

Conduit Size - 3 Conductors 
The following formula is applied: 
 

[Inner Diameter] **2 >= [Cable O.D.] **2 / [Ratio of Cross Section for More than Two 
Conductors] 

Gland Size 
When new records are created in DPPCGSelect or "Gland Type" changes from the previous one, the 
gland size (record) corresponding to the individual cable size is retrieved as an initial value from the 
cable gland library with the following criteria; 
 
Minimum gland size (minimum Cable O.D. Max for Gland) that satisfies; 
 

[Cable O.D. Max for Gland] >= [Cable O.D.] 
 
When the corresponding record is not found in the cable or gland library, the gland size will be left 
blank. 
 
If you like to change the calculated gland sizes, select the other size from the list box. 

Entry Thread Size 
When new records are created in DPPCGSelect or "Entry Type" changes from the previous one, the 
entry size of gland (record) corresponding to the selected gland type/size and entry type is retrieved as 
an initial value from the cable gland library. 
 
"Entry Thread Size" is indication only and not editable. Values of "Entry Thread Size" are always 
synchronized with "Gland Size" of the same records. 
 
 

<End of Chapter 13> 
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